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GIFMI MOCK MRI MANUAL 
1 INTRODUCTION 
In April 2010, GIfMI purchased a MRI Simulator from Psychology Software Tools, Inc. 
(https://www.pstnet.com). A MRI Simulator is a device to simulate the MR environment and experience of 
being scanned in a controlled, safe and cost-effective way. 
MR studies often require long scan periods with compliant participants. A MR study may be a traumatizing 
experience causing excessive movement resulting in data loss and lost funds. Especially in special populations 
like children, elderly and psychiatric or anxious participants this may result in a higher rate of premature 
termination of the study. 
Researchers too can benefit from the use of the MRI Simulator. They can get acquainted to the whole process 
of instructing and positioning subjects without occupying the real scanners. They can also train participants in 
a realistic environment to get acquainted with the paradigms. 
All this results in more effective use of scanner time, reducing the costs, optimize participant cooperation and 
higher data quality. 
More information on the benefits (including literature) can be found on the website of the manufacturer, see 
https://pstnet.com/product_category/mri-simulationtraining/. 
The MRI Simulator consists of several components which are all described below: 
For more information, go to the or contact Pieter.Vandemaele@UGent.be (GIfMI Site Manager). 
 

2 SYSTEM COMPONENTS 
2.1 MRI Simulator 
This is the main and largest component of the setup. The basic features are: 

• Standard 60 cm circular bore with tapered entry and front façade panel 
• Realistic scanner body with sturdy steel frame construction 
• Cooling fans and diffused lighting for participant safety and comfort 
• Amplified speakers with subwoofer for realistic scanner noise production and vibration 
• Quiet, motorized participant table with drag sensing safety stop and dynamic speed control 

(table speed ramps up or down for smooth starts and stops during participant insertion and extraction) 
• Integrated control panel for participant table operation, fans, and lights 
• Siemens mock birdcage head coil 
• Decomissioned coils (e.g.  

 
 

https://www.pstnet.com)./
https://pstnet.com/product_category/mri-simulationtraining/
mailto:Pieter.Vandemaele@UGent.be
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MRI Simulator Siemens mock birdcage head coil 
 

2.2 SimFX 

 
https://pstnet.com/products/simfx/ 

SimFx software simulates the ambient scanner sound and the active scanning noise. Four sound files can be 
played simultaneously. SimFx also has the capability to accept input from an experimental paradigm which 
can be used to simulate how the scanner synchronization pulse triggers an experiment. 
 

2.3 MoTrack 

 

https://pstnet.com/products/motrak/ 

MoTrak is a real-time head motion tracking system. The sensor attached to the subject’s head determines the 
position of the head in space relative to the transmitter. The sensor records angular rotations as well as 
positional displacements from an initially calibrated position. This information is displayed and logged by the 
program in real-time, allowing observation of head motion in the MRI simulator.  

2.4 Monitor 
A standard monitor is located at the end of the bore. Keep in mind that due to the mirror, the image is mirrored 
left-to-right. 

2.5 PC 
A PC is available to run the SimFX software. A researcher who wants to train subjects with a paradigm must 
bring a laptop. 
 
 
 

https://pstnet.com/products/simfx/
https://pstnet.com/products/motrak/
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3 LOCATION 
The MRI Simulator can be reached in the following ways: 
From outside: Entrance 71 – route 737 – room DWL.0.021 
From the MR Building: Hall DWL.0.060 – Hall DWL.0.005G – Hall DWL.0.007G – room DWL.0.021  
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4 ACCESS 
Access to the MRI Simulator room is only possible with a key. For sporadic access, please contact the GIfMI 
Site Manager to get the key. If you will be using the MRI Simulator frequently, please apply for a key with the 
GIfMI Research Assistant. 

5 BOOKING THE MRI SIMULATOR 
The MRI Simulator can only be booked using the CFMS. Contact the GIfMI Site Manager for more information. 

6 USAGE 
Manuals for the software and hardware are available as PDF file. Check the website to download the manuals. 
Available manuals are: 

• MRI_Simulator_Manual.pdf 
• SimFx_User_Manual.pdf 
• MoTrak_Operator_Manual.pdf 

A copy of the software is available upon request to the GIfMI Site Manager. 
  

https://cfms.ugent.be/
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7 SIMFX SOFTWARE 
Before continuing, be sure that you have administrator rights to install the software on the computer. If you do 
not have administrator rights, you will be unable to install SimFx. If you are unsure of your administrative 
privileges, contact your System Administrator. 
 

7.1 Software installation 
Unzip the provided ZIP file and run setup.exe. A wizard will guide you through the installation process. 
 

7.2 Opening the application 
Once you have successfully installed the SimFx software you can open the application through the Windows 
Start Menu. 
 
Start the application via the Windows Start 
menu or by double clicking the SimFx icon on 
the Desktop. 
 

 

 
Wait for the application to load  

 
The Graphical User Interface will show.  
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7.3 The User Interface 
7.3.1 General 
SimFx contains recordings of scanner sounds and ambient noise. It also supports adding your own files to the 
library. The software allows simultaneous playback of four audio files. The volume of each sound file can be 
adjusted individually during playback. The following file types are supported: .wav, .mpa, .mp2, .mp3, .au, .aif, 
.snd, and .wma. 
The library contains the following sound clips: 
 

Background Sounds 

File Name Scan type/Description Length 
Sound 
Type 

AmbientNoise.wav White noise, static 10s mono 
CryogenicPump.wav Noise from cryogenic pumps in scanner room 7.47s mono 
AmbientCryogenic.wav Ambient.wav and CryogenicPump.wav in one .wav file 7s mono 

 
Scanner Sounds 

File Name Scan type/Description Length 
Sound 
Type 

GE_DTI.wav Diffusion Tensor Imaging sequence 14.29s mono 
GE_SE.wav Spin Echo sequence 9.89s mono 
GE_EPI.wav Echo Planer Image sequence 4.89s mono 

GE_GRE.wav Gradient Echo sequence, 2D low resolution structural 
(InPlane) 

4.77s mono 

GE_SPGR.wav Incoherent Gradient Echo (RF Spoiled), Spoiled GRASS 
sequence 

7min mono 

Siemens_DTI.wav Diffusion Tensor Imaging sequence 16.80s mono 
Siemens_Echo.wav Fast Spin Echo sequence 10.35s mono 
Siemens_EPI.wav Echo Planer Image sequence 59.60s mono 
Siemens_Localizer.wav Low resolution structural image sequence 14.29s mono 
Siemens_MPRAGE.wav Gradient Echo 3D high resolution structural sequence 6m5s mono 

Siemens_PD-T2.wav Proton density T2 weighted Image sequence, low 
resolution structurals  

57.35s mono 

 

 
You need Administrator rights to add/change/remove any sound file. 
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7.3.2 Load Sound 
To load a sound file, click the Browse buttons located on the right side of the application, navigate to the 
appropriate directory and select the desired sound file to be played. The browse file window will automatically 
open at the designated location of the installed sound files. 
 
Click on the Browse button to select a file. 
 

 You will be directed to the default Sound 
Folder location which is: C:\Program 
Files(x86)\PST\SimFx\Sounds. XP users will 
be directed to C:\Program Files\PST\SimFx\ 
Sounds unless you designated a different 
location at the installation. 

 
 
 
 

 
 

Select a file. 
 
 
 
 
 
 
 
 
 
Click Open. 
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7.3.3 Play Sound File 
The Play and Stop buttons will be disabled until a sound file is loaded in one of the text boxes. The checkbox 
corresponding with the loaded sound file must be checked for SimFx to play the file. The sound file playback is 
controlled by the start and stop buttons located at the bottom of the application. 
 
Confirm the checkbox is checked. The text will 
appear in the digital display. 
 
Click Play to begin playback. 
 
Click Stop to terminate playback. 
 

 Once playback has started, the loaded 
sound file cannot be changed before playback is 
stopped. 
 
Check the equalizer. 
 

 If the equalizer is animated, but you cannot 
hear the sound, check if the system volume is 
muted or turned down and check the speaker 
connections.  
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7.3.4 Volume controle 
The volume control for each sound file is located below its digital display. The slider is used to control the 
volume of the associated sound file. To decrease the volume, drag the slider to the left, and increase the volume 
by dragging the slider to the right. 
 
Click and drag the slider left and right to 
increase or decrease the volume. 
 
The text below the slider indicates the volume 
level (%). 
 

 The volume control for each sound file is 
located below the digital display. 
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7.4 File Menu 
7.4.1 Basic Features 
The File Menu consists of two options, File and Help. The File option of the File Menu contains general 
application functionality such as the save, open, exit operations. The Help Menu contains a link to the 
documentation and information about the SimFx installation. 
 
New: This menu option clears all user defined 
configurations and returns the application state 
to default.  
Open: Allows a previously saved configuration 
to be loaded. 
Save: Saves current user configuration into a 
file, including the loaded sound files, volume 
slider values, the folder of sound files and the 
settings of the serial port. 
Save as: Saves current open user configuration 
into a file. The name of the file is specified by 
user. 
 

 

 
 
From here on advanced functionality will be described which is not strictly necessary to use the application. 
SimFx installs several sample sound files in a default location on the installation system. This location can be 
accessed via the File Menu for convenience. The default sound folder can also be changed to any folder located 
on the system. Please note, you must have administrator privileges to write to the default sound folder location. 
 
Click File and select Sound Folders. 
 
Click User Defined Folder. 
 
Browse to desired location you wish to save your 
sound files. 

 The sound folder must be in My Documents. 
 
Click OK. 
 
Confirm the Default Folder is set to the location 
of the sound files to be played. 
 
Click OK. 

 The location of the sound files can be reset 
at any time by selecting the Default Folder 
option via the File Menu. 
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7.4.2 Configuration 
SimFx can communicate with devices via serial connection. The serial port configuration can be set in the File 
Menu and Configuration option. You will need to determine which COM port is assigned to your serial port. The 
state of Serial Communications is displayed in the right corner of the application opposite the File Menu. Basic 
information regarding serial ports settings can be found in Section 8.5: COM Port Settings of the manual.  
 
Click File and select Configuration. 
 
 
Click the COM port drop down menu to set the 
appropriate COM port. 
 

 A warning dialog will appear if a port is 
unavailable on your machine.  
 
 
Click OK to close the Serial Communications 
dialog. 
 
Verify Serial Communication is enabled via 
the checkbox in the upper right corner of the 
user interface. 
 

 If Serial Communications cannot be 
enabled by checking the check box at the top of 
the user interface, please check that the device 
settings are correct, see Section 8.5. 
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7.4.3 Open Log File Location 
SimFx includes a log file that can be used to double check the application's functioning. The log file is opened 
via the File Menu. This file contains information and operations performed by the SimFx application. 
 
Click File and select Open Log File Location. 
 
 
 
 
 
 
 
 
 
The SimFxLogFiles dialog lists the location 
and file names of the available SimFx Log Files. 
 
 

 

 

 

 
SimFx log file is a tab delimited file like the example below and contains the current Serial Communications 
settings, current sound folder location, and a list of the operations performed by the SimFx application. 

 
   Current Sound Folder Location (sound file) 
  
 Serial communication settings (Initializing Serial Port ComPort = COM1) 
  
 List of Actions performed by application 
  
 What sound file is played (Audio File Location = Siemens_EPI.wav) 

SimFx Log 
--------------------------------- 
--------------------------------- 
Event Details 
SimFx Initializing N/A 
sound file:  C:\Program Files (x86)\Pst\SimFx\Sounds 
Initializing Serial Port ComPort = COM1, BaudRate = 9600, Parity = None, DataBit = 8, StopBit = 
One 
ConfigureSerialPort() 
Play Ambient Audio Audio File Location = AmbientCryogenic.wav 
Pause Scanner Audio via Checkbox Audio File Location = Siemens_MPRAGE.wav 
All sounds were stopped.  
Play Ambient Audio Audio File Location = AmbientCryogenic.wav 
Play Scanner 2 Audio Audio File Location = Siemens_EPI.wav 
All sounds were stopped.  
Play Ambient Audio Audio File Location = AmbientCryogenic.wav 
Pause Scanner Audio via Checkbox Audio File Location = Siemens_MPRAGE.wav 
All sounds were stopped.  
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7.4.4 COM Port Settings 
COM Port This option designates which port you want the program to use to communicate. 

Predefined values: COM1, COM2 
Default value: The User’s Default Communication Port (which will be found by SimFx) 
 

Baud Rate This option controls the number of data bits per second that are transferred via the 
selected port. 
Predefined values: 9600,14400,19200,28800,38400,56000,128000,256000 
Default value: 9600 
 

Data Bit This option will change the number of data bits you want to use for each character that is 
transmitted and received. 
Predefined values: 5,6,7,8 
Default value: 8 
 

Parity This controls the type of error checking the device performs. Please be advised that the 
computer or device you are communicating with must have the same setting as what you 
chose here. 
Predefined values: None, Odd, Even, Mark, Space 
Default value: None 

Stop Bit Changes the time between each character being transmitted. 
Predefined values: None 
Default value: None 

 

8 MOTRAK SYSTEM 
The MoTrak system is very complex. Contact the GIfMI Site Manager for more information. You can also check 
the manual on the website. 
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9 MRI SIMULATOR 
The MRI Simulator is easy to use. Below are some points of attention so that the device can last long if used 
properly. 

9.1 Power Supply 
The power supply for the Simulator is located 
towards the rear of the Bore section on the 
same side as the control panel. The Power 
Switch is a manual reset circuit breaker. 
 

 Make sure the power switch is in the OFF 
position before connecting  the Power Cable.  
 

 Contact the GIfMI Site Manager if 
something is wrong with the cabling.  
 
Next tot he Power Switch is the Audio Input. 
 
 
 

 
 
 
 
 
 

 

 
 

9.2 Controle Panel Instructions 
The Control Panel is mounted on the front 
panel.  
The control panel has three buttons: 
• ON/OFF switch for Lights 
• ON/OFF switch for Fans 
• Momentary button button to move the 

Participant Table in and out of the MRI 
Simulator Bore. 

 
 
 

 

 
 

9.3 Ventilation 
Two fans are mounted in the Simulator Bore. They are operated by a ON/OFF switch located on the control 
panel. When active, the switch on the control panel will be illuminated. 
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9.4 Lighting 
Lights are mounted in the Simulator Bore. They are operated by a ON/OFF switch located on the control panel. 
When active, the switch on the control panel will be illuminated. 

9.5 Participant Table 
9.5.1 Instructions 
A single press of the Table button on the control panel moves the Participant Table into the Bore. Pressing 
the button again stops the Participant Table and pressing it one more time will cause the Participant Table to 
move out of the Bore. The Participant Table will move slowly upon initiation and will slow down again when 
coming to a stop. The Participant Table is equipped with a safety mechanism to reduce the likelihood of injury. 
It will automatically stop the Participant Table if it encounters too much resistance. 
 

Emergency Release 

An emergency safety release is located at the 
foot of the Participant Table. The engaging the 
safety release mechanically disconnects the 
table from the mechanism, allowing the table to 
be moved manually. Pulling the knob towards 
the foot of the table releases the table from the 
Carriage Assembly. To re-attach the table, slide 
the Participant Table forward with a moderate 
amount of force until you hear the table lock 
back into the Carriage Assembly. Pull on the 
Participant Table to verify it has locked back in 
place. 

 

 

 

Remote Control 

The table can also be operated with a remote 
control with button (T). This works identically to 
the control button on the control panel.  
 
This can be a useful tool for researchers doing 
self-testing or piloting experiments. This also 
provides anxious participants an element of 
control by allowing them to move themselves 
out of the Simulator. 
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Mock Head Coil 

The Mock Head Coil is a two-piece unit 
designed to allow easy participant placement 
and simulation of “birdcage” style head coils 
used in actual MRI scanners. 
 
The bottom part remains on the Participant 
Table, the top part is easily removed for 
participant positioning. A mirror is mounted on 
the top part to allow the participant to look at a 
screen at the end of the Bore or towards the 
feet. 

 

 

 

Speakers 

The Simulator speakers can be driven by your computer audio card or any compatible sound source.  
The audio system of the Simulator consists of an Audio Input (3.5mm TRS plug mini jack) on the Power 
Supply and two Speakers on the side of the Simulator bore. 
 

 
To avoid hearing damage, it is important that the volume of the sound source is not too high. By 
testing in advance (without a participant in the bore) a comfortable sound level can be set. 
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Proper positioning of the Participant 

The following section is intended to help the researchers get optimal results from the use of their MRI Simulator. 
This is by no means an exhaustive list of proper or common simulator practices and procedures. It is intended 
to provide insight and suggestions to improve the simulator environment. 
The operator should go through all the steps that an MR technician would normally go through in a normal 
scanner session. They should include all items such as ear plugs and headphones, performing a standard 
screening just as they would in a normal scanning environment. 
• Be sure to explain the expected experience and all aspects of the test for the participant before conducting 

any testing. They should be allowed to handle the stimulus response devices, view the stimulus 
presentation system and any other critical aspects of the scanner environment. 

• If the participant is to be given the Participant Table Remote Control or any emergency device, instruct 
them on its usage and allow them to use it several times to assure their comfort and confidence of use. 

• Upon completion of the experiment and withdrawal of the participant from the Simulator, conduct an exit 
interview to the participant. Exit interviews provide valuable information that might highlight potential 
problems that may occur in the actual MR runs (feelings of panic, discomfort, etc.) and can be used as 
feedback to improve the simulator environment. 

• Explain any differences between the simulator and actual scanner experience. Some examples might be: 
room temperature, separation of the scanner and control rooms, and the presence of additional staff. 

• Each participant reacts differently to the MR environment. It is important to acknowledge this and to offer 
a training tailored to the participant. 

 

Points of Attention 

 The maximum load-bearing weight is 125 kg. 

 
Ensure that the hands and hair of the subject cannot get between the table and the bore to avoid 
injury. 

 Make sure the sound volume has been tested beforehand to avoid hearing damage. 

 Make sure that the participant can safely get on and off the table by using a step. 

 Make sure that everything stays clean. Do NOT use alcohol but water or the available tissues. 

 Ensure that participants are sufficiently instructed about the course of the practice session. 

 Make sure the emergency stop works. 

 
Servicing may only be done by qualified personnel. In case of problems, contact the GIfMI Site 
Manager. 

 
It is possible to copy the sound files from the default location (see section 8.3.2) to an external. The sound files 
can be played independently of the SimFx software. Given the short duration of the sound files, it is 
recommended to put the player in "loop" mode so that sounds are repeated continuously. 
 
With certain populations, and especially with children, multiple training sessions might be necessary. After a 
visit to the MRI Simulator, the child can practice at home by lying very still on bed and listening to the sounds. 
session. 
 


